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Chapter 1

Introduction
This chapter provides an overview of the Map95v2 software features and capabilities.

ongratulations on the purchase of Map95v2 graphical mapping software. Map95v2 is simple, easy to 
use visual mapping software for the Loop Telecom O9500 and O9550 SDH/SONET integrated multi-

services access platforms. By default, the O9500 and O9550 use a VT100/telnet user console for card 
configuration, system configuration, mapping, etc. As more cards are added to the O9500 and O9550 
platforms, cross-connecting (mapping) DS0s can become confusing and time consuming using the 
serial/telnet console. Map95v2 provides clarity using graphical representation of the equipment, which 
speeds up cross-connect mapping and documenting unit cross-connections and configuration details.

C

Productivity Software for O9500/O9550 Configuration

Map95v2 software is productivity software with graphical mapping. Map95v2 is a craft tool that fills the 
gap between the serial/telnet console and complex network management and circuit provisioning systems.

Configure O9500/O9550 Cards

Map95v2 is used for the TSI (Time-Slot Interchange) cross-connect, commonly called “mapping.” Like 
mapping, card system configuration can often be performed using the serial/telnet console port or Map95v2.
There are a few functions that can only be done using the serial/telnet console, such as card registration, unit
IP address, SNMP parameters, and router card configuration.

Map95v2 Export and Import Functions

Map95v2 software has a map export and import function. TSI (Time-Slot Interchange) cross-connect maps 
can be exported in a comma delimited (csv, or comma separated values) format for import into spreadsheets
or in text form for word processors. Create system documentation quickly and efficiently with the export 
function. Spreadsheet files may be modified off line and imported back into the O9500, creating or 
modifying the time-slot cross-connect map. User added rows beginning with “#” are ignored on import.
Additional descriptive columns can be added after the 10 columns that contain the mapping data.

Windows XP,  Vista, 2008R2, 7, 8 and 10 Compatible

Map95v2 operates with Microsoft Windows XP, XP-Pro, Vista, 7, 8, and 10, both 32 bit and 64 bit, as well 
as Windows 2008R2 (which is 64 bit only). 

Map95v2 Licensing

Map95v2 software is licensed per controller. Each O9500/O9550 requires one or two license keys, one per 
controller. One license file (.lcf) is created per O9500/O9550. Once Map95v2 and a license are purchased, 
it can be distributed to an unlimited number of PCs and used by an unlimited number of technicians on that 
O9500/O9550. Licenses are available from DCB and can be granted almost immediately using e-mail.
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Map95v2 software accesses the local license (.lcf) file each time a connection is made to an O9500/O9550.

Map95v2 and SNMP Version 1 or Version 3

Map95v2 uses SNMP commands to communicate with the O9500/O9550. Therefore, Map95v2 requires an 
Ethernet connection to the O9500/O9550. The O9500/O9550 can have extensive mapping that can take 
time to read from an O9500/O9550 or import into an O9500/O9550. An Ethernet link with low propagation
delay from the PC to the O9500/O9550 will minimize the wait time for these operations. Map95v2 supports
both SNMP Version 1 and SNMP Version 3.  (The O9500/O9550 does not support SNMP Version 2.) 
SNMP Version 3 uses authentication keys for secure connections. For SNMPv3, context, user name and 
keys are required.

Demonstration Version

For demonstration purposes, Map95v2 is available with a 30 day demo license. If interested in a demo 
license, please do one of the following: 1) contact your DCB sales representative, 2) call DCB at 217-897-
6600, or 3) e-mail DCB at sales@dcbnet.com.

Map95v2 Applications

Map95v2 is an ideal tool for telecommunications technicians who work with the Loop O9500/O9550 
products. The learning curve for mapping the O9500/O9550 is dramatically reduced by using graphical 
mapping rather than the serial/telnet console mapping method. Accuracy is increased.  

Once an O9500/O9550 is in service, changes are intermittent. Graphical representation of the mapping and 
the simplicity of the visual process makes recall of the mapping process much faster.

Copies of the Map95v2 software can be distributed to an unlimited number of users. The software license is
per O9500/O9550 unit/controller. License files can be duplicated and used on any number of PCs.    

Other Features

Visual Highlight and Click Mapping

To map a DS0 or multiple DS0s, DS0s to be mapped are highlighted and the “Map” button is clicked.     
Unmapping uses the “UnMap” button. Analog DS0s are visually differentiated from digital DS0s.

Significant Time Savings

Every cross-connect mapping operation reduces a couple of dozen terminal key presses to a simple 
highlight and click operation. Visual mapping can save hours of hours of effort for a loaded O9500/O9550 
chassis.

Increased Accuracy

Links between feature cards are visually displayed. The visual display with varied colors is much easier to 
understand than row and column presentation of mapping.
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Auto-Selection of Voice or Data

The mapping software automatically selects voice or data when low speed feature cards are mapped. E&M 
cards are unique. E&M cards can be set to voice or data, whether set to Transmit Only (TO) or Tie Line 
Types I through V.

Change SDH/SONET Granularity with a Mouse-Click within Map95v2

For unmapped SDH/SONET transport segments on the XCU controller cards and the SDH/SONET 
tributary cards, the granularity can be changed with a right-click that opens a pop-up window of radio 
buttons for various granularity settings. 

Change T3 Framing with a Mouse-Click within Map95v2

For unmapped T3 ports, a right-click opens a pop-up window of radio buttons with choices for unframed, 
C-Bit or M-13 framing.

Change Ethernet High Speed Trib Card Mode and Payload Mode with a Mouse-Click

Use a right mouse-click with unmapped high speed Ethernet tributary cards to bring up a box with radio 
buttons to change mode (e-line, e-lan, portmap) and payload mode (granularity).

Multiple Ways of Viewing Mapping

Map95v2 provides simple or complex map views.  As more and more cross-connects are made, it becomes 
important to provide a method of viewing the map in smaller segments to avoid confusion. Map95v2 also 
has an SNCP (Sub-Network Connection Protection) view to show primary and protected paths.

Short Learning Curve

Visual mapping is more intuitive. More of the mapping options are on the single mapping screen.

Small Program Footprint

The mapping software is a small, efficient program. Users can open multiple program copies when 
configuring multiple O9500/O9550s to better visualize the communications links.
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Chapter 2

Installing the Map95v2 Program
This chapter details the installation process.

Overview

Map95v2 comes as in installer file for Microsoft Windows XP, Vista, 7, 8, and 10. To install the software, 
execute the file with a name similar to “Map95v2_v2_05.exe”. Please follow the on screen procedures to 
complete the installation. The following three questions will be asked during the installation process: 
acceptance of the End User License Agreement (EULA), the installation location of Map95v2, and if the 
creation of a desktop icon  for Map95v2 is desired.   

Installation

Run Map95v2_vN_YY.exe File

Run the latest file “Map95v2_vN_YY.exe”. The displayed screens are listed  in sequence below. Follow the
on-screen instructions: NOTE: If an older version of Map95v2 is already installed on your system, it is not 
necessary to remove it before installing a newer version of Map95v2.
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The license agreement, shown on the following page, must be accepted to continue the software installation.
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Choose the location to install the program's shortcuts or select the default location. 

 Select a start menu folder for the shortcut location.
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On this screen you can choose to create a desktop icon if desired.  You can also install the additional visual 
C++ run-time libraries that are needed for some of the embedded tools to function.  On a first time install 
this check box will be checked by default, and on subsequent installs it will not.   It is okay to leave it 
checked as the system will notify you if the files are already installed (They normally are).
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Select Install.

Click on Install to proceed with the program installation. The program typically installs in less than a 
minute.

After the Map95 files are installed and if you checked the Install Microsoft Visual C++ 2019 run-time 
libraries you will see the screen below.  You need click in the I agree box and click on Install
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If the  Microsoft Visual C++ 2019 run-time libraries are already installed on your system you will see the 
following screen.  If this occurs just click the close button – and the installation will complete.

The program is now installed.  If you  check the box Launch Map95v2 , the program will be launched 
when the Finish button is clicked.
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Start the Map95v2 Program

 Click on the screen icon or run Map95v2 from the Program Manager.  
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Chapter 3

Creating License Files
This chapter describes the process for creating license files. A license file is required for 
each O9500/O9500 that is managed.

Overview

  Map95 can be licensed on a per unit basis or via an Enterprise license.   When you first launch Maa95 you 
will see the device configuration screen as below.

This screen will also allow you to activate built in serial version of PUTTY, so you can configure IP 
addressees and other initial setup information on a new unit that is connected to your PC's serial port. 
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Entering an Enterprise license key

If you have an Enterprise Key, you will click on the KEY button in the lower left hand region of the screen. 
This screen will then  pop up.  This only needs to be done once per installation of Map95v2 on a PC.
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Here you must enter the company name exactly as it is spelled / capitalized on the Issued To: portion of you
Enterprise license key certificate.   You will also enter the 16 digit Enterprise license key.   Once you have 
entered both click OK.

You will then be returned to the Select Device Configuration screen. 

The controller serial numbers are used by DCB to create a 16 digit license key. The serial number(s) and 
the 16 digit license key are used to create the license key file (lcf)
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New Device Setup or Edit Configuration 

Since a O9500/O9550 has one or two controllers, each .lcf file beeds to know the the controller serial 
number(s) for that unit as well as the SNMP management IP address, SNMP login credentials, and a file 
name/path to store the additional endpoint name data.  To set this information of the first time on a PC,  
click the New Device button – to change an existing file navigated to it with the Browse button and then 
click Edit Device.   You will see the following screen after clicking either:

Edit Device Configuration Screen

Entering Device Configuration Information

1. Enter the IP Address or Host Name of the O9500/O9550

2. Select SNMPv1 or SNMPv3. The details entered must match the O9500/O9550. For example, for 
SNMPv1, the Get Community and Set Community must match between the .lcf file and the 
O9500/O9550.
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3. Enter the Controller-1 Serial Number (and Controller-2 Serial Number if a second controller is 
present) which can be  obtained from the serial/telnet screens of the O9500/O9550. OR Click the  
Probe for Serial Numbers . Sometimes it requires a second click to find the second serial number)

4. If you do not have an Enterprise license then enter the  the Controller-1 License Key (and Controller-2
License Key if a second controller is present) provided on your license certificate to match that 
controller card serial number.

Completed Device Configuration Screen

The sample Edit Device Configuration screen below has the controller serial number and license key 
entered into the fields near the bottom of the screen. 

Click on the Save As button to complete the configuration.
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Chapter 4

Using Map95v2
This chapter describes how to use the Map95v2 program.

Overview

There is a single main screen for mapping operations. The Map95v2 main screen showing a partially 
populated O9500 is shown below. The illustration is annotated with explanatory notes and arrows in red. 
The screen can be expanded to a third column for SNCP (Sub-Network Connection Protection) mapping, 
explained later in the manual.

Map95v2 Main Screen Annotated
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Cards in the O9500/O9550 are keyed yellow for tributaries, green for the XCU/controller cards and gray for
the low speed AM3440/channel bank type of cards. Map95v2 mimics these colors within the Map95v2 
program.

The blue section in the middle, the Virtual Tributary Envelope (VTE) portion, does not relate to a physical 
card in the O9500. The VTEs are virtual T1s or E1s, represented two ways; as full T1s/E1s (DS1 view) or 
as individual DS0s. More about this on the following page.

A small chassis view is shown at the bottom-right. This can be moved around the screen or the chassis view 
can be turned off via a selection under the drop-down View menu. The small chassis view is useful as a 
reminder of the physical position of the cards in the channel bank. 

Map95v2 has a cross-connect section represented in blue. This blue section is located between the green 
XCU/controller cards and the low speed cards and is the virtual (VTE) mapping section. VTE stands for 
Virtual Tributary Envelope and represents a virtual T1/E1. There are two views of the virtual section. The 
DS1_View at the VT1.5 (T1) or VT2 (E1) level, and the DS0_View, which is the DS0 view of the VTE 
section. The VTE section must be used to cross-connect between the low speed tributary cards (gray 
section) and the XCU (green) and high speed tributary cards (yellow). The VTE section must also be used if
it is necessary to cross-connect, at the DS0 level, circuits that never get down to the low speed tributary card
section (gray), that is, trib to trib, XCU to XCU, or trib to XCU, at the DS0 level.
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VTE type is set using the serial/telnet console. From the main O9500 screen, select G – Map Setup, then 
select M – TE Mapper. Here there is a choice for T1, T1-VT12 or E1.

The T1 setting results in 28 DS1 VTEs with 24 DS0 time-slots each for a total of 672 DS0 time-slots.

The T1-VT12 setting results in 21 DS1 VTEs with 24 DS0 time-slots each for a total of 504 DS0 time-slots.

The E1 setting results in 21 DS1 VTEs with 31 time-slots each for a total of 651 DS0 time-slots.

VTE Screen Used to Set VTE Type to T1 or E1

18



Map95v2 Users Guide

Drop-Down Menus

File Menu

The File menu has options to Select Device, Export Map, Import Map, PrintScreen, Transfer, and Exit 
the program.

1. Select Device will open the same window the users sees when the Map95v2 program is initially 
opened.  Options are to Connect to Device, connect to a New Device (generating a new license key
file), Edit Device (an existing device license key file), Browse for an existing license key file, or 
Exit the program.

2. Export Map exports the map in comma separated value format (csv) or text report format (txt), 
and includes assigned time-slots, unassigned time-slots, or both.  

Choose All Time-Slots or Only Mapped Time-Slots
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The user is prompted to select to location to store the file, and to name the file.

The map, after the csv file export, formatted in a spreadsheet, looks like the sample below:
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3. Import Map imports the map from a csv spreadsheet.  The imported map must be in the same 
format as it was exported.  It is recommended that a map be exported and examined to see the 
format required for a map to be imported.  A sample of the exported map as expressed in a 
spreadsheet is illustrated above.  Comment rows beginning with “#” can be added.  Additional 
descriptive columns can be added after column “U”.  The added “#” rows and descriptions 
following column “U” are ignored on import.  The Import Map feature provides a way for a map to
be modified offline, to be restored to an earlier version, to be moved to a different unit, etc.  
Selecting Import Map brings up a standard Windows file selection menu as shown below. This 
may differ slightly based on view options.

File Selection Menu for Map Import

Importing a file   can take a long time. The following screen comes up to remind the user of the potentially
long import time, how to speed up the process, and the consequences of an aborted import process.
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4. Print Screen is used to print the current view.

5. Transfer is used to print the current view. Click on Transfer for the sub-menu of additional 
choices. Transfer uses a TFTP file server, built into the Map95v2 program. If the Map95v2 
transfer function is used, any other TFTP file server running on the PC must be closed first. This 
will avoid conflicts between two running TFTP servers.  

“Get” is equivalent to the O9500 upload function. Files are moved from the O9500 to the PC.

“Send” is equivalent to the O9500 download function. Files are moved to the O9500 from the PC.

RTB cards are included in for Get and Send functions because unlike other cards, configurations 
are stored on the router cards rather than on the controller.
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File Transfer Selection

File Transfer Options
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View Menu

The View menu has options to Show Chassis which is the small representation of the chassis, SNCP View 
which brings up a 3rd column for SNCP mapping, or Simple View of the TSI map which reduces the 
number of interconnect lines for a cleaner view of mapping, especially for very complex maps.

View Drop-Down Menu

Virtual Chassis View (which can be toggled on and off)

SNCP View – See Chapter 6 for more details
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Simple View, no interconnect lines across the screen

Simple View toggled off, interconnect lines across the screen

In addition to the Simple View toggle, at the top of each card column is a box to Expand All or Collapse 
All. Click on these boxes to either compress the vertical column view as much as possible or expand the 
vertical column view to its maximum extent.  

Fully expanded, the vertical columns can have hundreds, even thousands of time-slots....too many to view 
on even a floor-to-ceiling monitor. In a fully expanded view, the side bars are useful to quickly move 
upward or downward through the many time-slots. The Expand All, Collapse All, slider bars, “+” and “-”, 
Simple View toggle and SNCP View, can all be used in combination to efficiently navigate through the 
cross-connects. Below are sample screenshots contrasting the Expand All and Collapse All views.
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Collapse All, SNCP View Off

Expand All, SNCP View Off
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Collapse All, SNCP View Toggled ON

27



Map95v2 User’s Guide

Expand All, SNCP View Toggled OFF

Tools Menu

The Tools menu has options to Retrieve a TSI map, Clear a TSI Map, or Refresh the TSI map.

1. Retrieve Backup Config issues a command to the O9500 to perform a retrieve operation. This is 
the same as "retrieve" in the serial/telnet console. The O9500 re-reads the last stored configuration.
After the retrieve operation completes, the Map95v2 software will automatically refresh the screen.

2. Rescan device re-reads the TSI map (current map, Map 1, 2 3 or 4 as shown on the top-right 
portion of the Map95v2 screen) and returns the view on the screen to the default (unexpanded) 
state. For a more detailed view, it will be necessary toggle the “+” next to each interface. 

3. Clear Map1 and Clear Map2 causes the Map95v2 software to re-read the map from the O9500. 
This comes in handy if the user goes in with the serial/telnet console and directly modifies the map.
It is also useful if there is a communication error between the Map95v2 software and the O9500 
and Map95v2 gets out of sync. Some of the Map95v2 error messages will instruct the user to recan
the O9500/O9550.. 
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4. Telnet Console  opens a telnet session with the O9500.

5.    Serial Console probes the COM ports and virtual COM ports (for example, if a USB to serial 
adapter is being used) to facilitate a direct serial connection to the O9500/O9550's console port.

29
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6.    SSH Console opens an ssh (secure shell) connection with the O9500/O9550. Upon opening an ssh 
connection to the O9500 for the first time, a pop-up window pertaining to the O9500/O9550's host key 
will appear. To cache the O9500/O9550's host key, select Yes. Once that is done, this pop-up window 
will no longer appear. If No is selected, the next time an ssh connection to the O9500/O9550 is opened,
this message will appear again. Note: It can take about 15 seconds for encryption keys to be exchanged 
and the “login as:” prompt to appear on the screen. As with the telnet console, once authentication is 
complete, the main Controller Menu will open.

30
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Reset System facilitates a “warm” or “cold” reset of the O9500/O9550. Each controller card has two 
firmware banks. A warm reset will cause the controller to switch firmware banks such that the secondary 
firmware bank becomes the active firmware bank. This process can take a couple of minutes, during which 
time network access to the controller will drop. However, during a warm reset, traffic on the O9500/O9550 
tributary cards will not drop. A cold reset is the same as power-cycling the unit, thus traffic on the tributary 
cards will drop.

System Cold Reset – same as power-cycling the unit.

System Warm Reset – will cause both controllers, each which have two firmware banks, to switch which 
firmware bank is in use. Traffic on the tributary cards will not drop.

Working XCU Cold Reset – will behave differently depending on whether there are one or two controllers 
in the unit. If there is only one controller in the unit, then this option will be the same as power-cycling the 
unit. If there are two controllers in the unit, this option will immediately cause the secondary controller to 
become the active controller while rebooting. Once the secondary controller is made the active controller, it 
will remain the active controller even after the cold reset is complete.

Working XCU Warm Reset – will cause the working controller to switch from one firmware bank to the 
other firmware bank. While this process is taking place, traffic on the tributary cards will not drop.

Standby XCU  Cold Reset – same as power-cycling the standby controller.

Standby XCU Warm Reset – will cause the standby controller to switch from one firmware bank to the 
other. 
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Map Menu

The Map menu allows selection of Map1 or Map 2.  The O9500/O9550 has up to two maps. Only one of 
the two maps is working at any time. Most applications use only Map 1. More than one map may be used if 
there is a need to work on a new map without disturbing a current working map. Maps can also be 
operational by time of day or night. For example, one map may be used during the day to carry primarily 
voice traffic. At night, a different map may be desired to increase bandwidth for data transfer.

The current map being managed by the Map95v2 software is shown in the upper-right of the main screen.

Select Map will open a pop-up window to select which map is viewed and edited.

 

Activate Map will open a pop-up window for the selection of which map is the active map.

32
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Read All Cross-Connects will cause Map95v2 to rescan the unit via SNMP. This is useful when a tributary 
card has been added or removed.

Help

The Help drop-down menu has an About selection that displays the current software version of Map95v2.

33
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O9500/O9550 Chassis Images

Map95v2 by default displays a small view of the O9500 and the installed cards. To the left hand side are the
power supply slots, then the 4 Tributary slots with a yellow color key. In the middle are the two XCU slots. 
To the right of the XCU slots are six low speed slots for channel bank type cards, compatible with single 
slot AM3440 slot cards. These six low speed slots function like a channel bank, or multiple channel banks, 
and they have the features and mapping functions of the AM3440.  

The chassis image can be selected and moved around the PC screen by left-clicking on the image with a 
mouse. Holding down the mouse button allows the user to move the image.

The chassis image does not show the VTE mapping space, as the VTE mapping is a memory only function. 
There is no physical card representing the VTEs.

The chassis image can be made to disappear using the View menu and un-checking Show Chassis.

O9500 Chassis View

34
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Picking a Card Slot with a Mouse-Click

Below is a partial image of the Map95v2 screen. Note the cards have boxes to the left with “+” signs in the 
box. The “+” indicates that the card has further sub sections that are accessed by clicking on the “+” or the 
card name. If the right hand side of the mapping screen was shown, the “+” would shown to the right of the 
card name. After clicking on the line, the card expands to sub sections. The second illustration below shows
the E3/T3 card expanded to show that Port 1 of the 3 ports of the card is set to unframed DS3 (STS1) and 
that Port 2 is framed, showing a few of the 28 VT15 circuits. Right-clicking on an unmapped high-level 
section of the card brings up a box with radio buttons, allowing the user to set the granularity of the card, or 
subsection of the card.

Click on the “+” to get to the lower granularity sections of a card. As long as there is a “+”, there is a lower 
granularity than currently shown. When there is a “-” or no sign, the display is at the lowest granularity 
level. Click on the “-” to move up to show less granularity. This may cause cross-connect lines to change to 
short arrows by the card.
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No Function to Turn CAS ON or OFF “On the Fly”

Unlike Map34, Map95v2 software does not allow CAS to be changed from CAS OFF to CAS ON, and ON 
to OFF “on the fly”. This is due to the complexity of cross-connects that may tie from the DS0 level to the 
SDH/SONET level by way of VTEs (the virtual DS0 to VT1.5 or VT2 mapping space in the O9500).

Selecting Time-Slots to Map

Select the time-slots to map by highlighting them. Hold down the left mouse key and slide over the desired 
time-slots. The time-slots will be highlighted in a darker gray. The same number of slots must be picked on 
the top and the bottom cards.   
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Selection of Voice or Data for Low Speed Cards
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Automatic Selection of Voice or Data for Low Speed Cards

Low speed cards are non-transport cards. Voice low speed cards are FXS, FXO, and E&M. Data  low speed
cards include the DTE cards, 8DBRA, 8RS232, router cards, etc. High speed cards, or trunk circuit cards 
that can have DS0s manually set for voice or data,  include T1, E1, FOM, G.SHDSL, TDMoE.
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Select Voice or Data for Pass Through Time-Slots

If one transport card is mapped to another (T1 to T1, E1 to E1, T1 over FOM, E1 over FOM, VTE DS0 to 
VTE DS0, etc.), and not directly to a low speed voice time-slot, the DS0 may or may not carry voice traffic.
If the time-slot does carry voice traffic, the card must be mapped as voice. If the time-slot does not carry 
voice traffic, the card must be mapped as data. Proper designation of voice or data is required for the voice 
signaling bits (AB bits or ABCD bits) to pass through the system correctly. Exception: E&M DS0 time-
slots may be set as data if being used without the need to pass the ABCD bits. Setting an E&M as 
data, rather than voice will improve the signal to noise ratio (SNR) by about 3 dB. Transmit Only 
(TO) E&M circuits will never use the ABCD bits, whether the DS0 is mapped as voice or as data. If 
Type I through V type E&M circuits are set to data, the E&M leads will not function. However, they 
may chatter on and off, since the ABCD bits are not present. Chattering can be stopped with 
appropriate wiring of the E&M leads (or the user can put up with the relay chatter).

The illustration below shows several time-slots selected for mapping. Prior to mapping, the user should 
select either voice or data for the DS0s.
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Bidirectional and 1:(N)Multicast 

The O9500 can be configured for bidirectional mapping or unidirectional. The Trib and XCU time-slots can
always be either bidirectinal or unidirectional. The VTEs and the six low speed slot DS0s default as 
bidirectional but can be set to 1:(N)Multicast. The 1:(N)Multicast allows for unidirectional mapping.

To change between bidirectional to 1:(N)Multicast for the low speed cards, from the main O9500 system 
screen select “G”, then “C”. This brings the user to the menu shown below.

Default Bidrectional mapping

  

1:(N)Multicast mapping option.

This is a Bidirectional Mapping.  Only the Center Map Option is Highlighted.

The above shows the two unidirectional options and the bidirectional option for the 1:(N)Multicast setting.
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Note That Tributaries and the XCU Cards are Always Capable of Unidirectional or Bidirectional
Mapping.
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Activate, Store the Map

The O9500 activates the mapping as soon as it is mapped. There is no activate function.

The O9500 also automatically stores the map after five minutes. If the user wishes to force a store, this can 
be done through the serial/telnet port. From the main system screen, select the “V” option. If the O9500 is 
set up on the bench or in a lab prior to field installation and the unit will be turned off immediately after 
mapping, forcing a store is recommended. Below are the screens used to store.

Select the V option to force a Store operation

Select STORE to save the configuration. The save takes up to two minutes.
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FOM (Fiber Optic Module Cards) and Time-Slot 16

The O9500 has a 7-port FOM card. Each FOM physical I/O port can carry up to four ports of 31 time-slots, 
equivalent to 4-E1s per each of the 7 physical optical ports. The FOM card also transports time-slots as 
voice or data. To transport voice, the FOM card must to set to FRAME ON and CAS ON.

When set to CAS ON to transport voice, time-slot 16 of the E1 is not available for mapping. It is 
automatically selected for signaling. T1 carries the signaling bits (ABCD bits that signal on-hook, off-hook, 
ring, etc.) within the DS0 as inband “robbed bit” signaling. When T1 traffic is carried over the 7-FOM card,
the ABCD bits which are in the T1 DS0s, are moved automatically into time-slot 16 of the 7-FOM card 
E1s.

Note: If a 7-FOM card is used as a tributary card in the O9500 and the O9500 has T1s in the low speed 
slots, the VTEs must be set to VT2 mode, not VT15 mode. This means that all the tributary cards and the 
XCU cards must also use VT2 mode, rather than VT15 mode. Any O9500 or other SONET device 
connected to the O9500 must also match the VT2 mode.

UnMap Time-Slots

Click the time-slots to select what should be unmapped. The selected time-slots will be highlighted. Click 
the UnMap button on either side of the screen to UnMap bidirectional mapping. Click on the arrow head 
side to UnMap unidirectional mapping on the right hand side of the screen.

Controller Card Configuration

Most configuration of the O9500/O9550 controller cards is done using the serial/telnet console. It is 
possible to set the granularity of each physical port on the controller card to either STS3 (each STS3 
consisting of three STS1 channels, and each STS1 consisting of 28 VT1.5 channels) or STS3C (all of the 
STS1s are concatenated together and no further granularity is permitted). This is selected by right-clicking 
on the STS3 channel (for example, STS3-01) and selecting the desired option.
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Setting the granularity on the controller card to STS3 allows for another granularity setting to be set on the 
STS1s that comprise the STS3. By right-clicking on either STS1-01, STS1-02, or STS1-03, the following 
virtual tributary settings are available:

The mapper type (T1 or E1) for the virtual tributaries (mapping stored in memory to facilitate mapping low-
speed ports, such as T1 or RS232 ports, to high-speed SONET ports) can be set by right-clicking on one of 
the virtual tributary ports under the DS1 view, such as: VTE1: DS1_View. When the mapper type is set to 
E1, there will be 21 VT2 ports visible under one of the virtual slots (such as VS-01). When the mapper type
is set to T1, there will be 28 VT1.5 ports visible under one of the virtual slots.
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Map95v2 can also configure the virtual ports that are part of the virtual slots (such as Port-01 under VS-01).

Tributary Card Configuration

Some of the tributary cards in the O9500/O9550 can be configured completely using Map95v2. Some cards
can be partially configured using Map95v2, such as the TDMoE card, which while some settings can be 
adjusted, input of source and destination TDMoE IP addresses can only be done from the serial/telnet 
console. Also, some tributary cards can only be configured using the serial/telnet console, such as the RTB 
(router B) card.

Right-clicking on the tributary card ports will result in either a single configuration menu or a sub-menu that
presents the options of configuring the card or creating a label for the port. Examples are below:
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Quad T1 card configuration:
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8RS232 card configuration:
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8E&M card configuration:
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Labels for Tributary Card Ports and Time-Slots

Map95v2 can be used to associate comments/labels with ports and time-slots on the various tributary cards 
and virtual tributary channels.

NOTE: These comments are not stored anywhere on the O9500/O9550, but rather in a file located on the  
PC with Map95v2. Each device should have it's own comment file. If such a file does not exist, the user will
be prompted to create one. Note: If many users and many laptops will be used to access an O9500/O9550, 
storing the comments files on a centralized file server is recommended. 

Right-click on the port that needs to the label.
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Once the label has been added, it will be visible under the expanded view.

When right-clicking on a port that can be both configured and labeled, such as on 8-port E&M tributary 
card, a pop-up menu will appear offering a choice to configure the port or to label the port.
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Select Edit Endpoint Information and add the desired information. It will then be visible under the 
expanded view of the tributary card, in this example, the 8-port E&M tributary card.
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Chapter 5

Operations Requiring the 
Serial/Telnet Console

This chapter describes what functions must be done using the serial/telnet console 
configuration functions that are not part of Map95v2.

Overview

The original version of Map95 began the process of making time-slot mapping in the O9500 faster and 
more accurate and aided in documentation. Many functions, such a tributary card configuration, could not 
be accomplished in Map95, thus requiring certain tasks to be completed via the serial/telnet console. The 
program was a complement to the serial/telnet console, not a substitute. With the release of Map95v2, many
tributary cards in both the O9500 and the O9550 can be configured via the GUI interface. However, some 
functions can only be configured via the serial/telnet console interface. 

System Configuration
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SNMP Configuration

SNMP System configuration is via the console.

Router Card Configuration

The RTB router card is configured using the console.
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Serial Data Card Configuration

Serial data cards require the serial/telnet console for system setup.
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Chapter 6

SNCP Mapping
This chapter describes the SNCP mapping.

Overview

SNCP is Sub-Network Connection Protection. SNCP is a per path connection protection. SNCP mapping 
has a primary and secondary path for the protected circuit.  

To use SNCP mapping, under the View drop-down menu, select SNCP View. This changes the mapping 
view from two columns to a three column view. The center column is the local Protected circuit end point. 
The right hand column is the Primary link, the left most column is the Secondary path.

Below are two screenshots annotated to show the three column view and highlight the key functions. The 
first screen shows time-slots selected, to be mapped. The second screen shows time-slots mapped. Time-
slots must be selected in all three columns. After selecting the proper number of time-slots, the <-PP-A&D-
> box will be highlighted. Click on the highlighted box to complete the mapping.
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Appendix A

Specifications

Map95v2 Specifications

 Map95v2 works with the Loop Telecommunications International O9500 and O9550, as well as 
selected OEM/ODM versions.

 Map95v2 runs on Windows XP, XP-Pro, Vista, 7, 8 and 10, both 32 bit and 64 bit, as well as 
Windows 2008R2 (which is 64 bit only).

 Map95v2 requires a license for each O9500/O9550 controller it supports.
 Map95v2 may be used by an unlimited number of technicians on an unlimited number of 

workstations.
 Map95v2 is licensed software owned by Data Comm for Business, Inc., 2949 CR 1000E, 

Dewey, Illinois, 61840, Tel 217-897-6600.
 http://www.dcbnet.com
 Link to check for upgrades to newer versions: 

http://www.dcbnet.com/download/index.html#map95
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